
 

  

This user’s guide is for use with Version 2.0 of the HomeSeer software. 

If you are an experienced HomeSeer user, please see What's New in this Version for a quick summary of the changes in this version. 

HomeSeer is an advanced home automation package designed to take full advantage of the features available in your PC such as Internet 
access, E-mail, text-to-speech, and others. These features are typically not available in stand-alone controllers.  The software was designed 
to be easy-to-use yet flexible enough for advanced users. 

HomeSeer works automatically by responding to events that you configure.  For example, a motion detector causing a light to be turned on 
if it is dark is an example of an event that you might want to set up.  The motion detector sending an ON signal is a trigger, whether or not 
it is dark is a condition, and turning on a light is an action.  These terms will be referred to several times throughout this help file. 

All things that happen automatically are because of an event.  HomeSeer can be controlled by voice, web browsers, touch screens, PDAs, 
even instant messaging programs.  For example, you can run a pre-defined set of actions (configured in an event) in response to a button 
pressed in a web page or a phrase spoken into a microphone or telephone. 

HomeSeer is designed to work with a wide range of home automation devices.  Support for new devices is through the use of Plug-Ins. New 
plug-ins are constantly becoming available through HomeSeer Technologies, as well as third parties and end users.  Check our support web 
page and our message board for the latest plug-ins that are available.  Some plug-ins are purchased separately.  Here is a partial list of 
hardware that HomeSeer supports -- please visit the HomeSeer website for more information: 

HomeSeer Technologies Z-Wave USB Interface 

TouchPad devices, PDAs, and other micro-browser based devices 

Windows Media Player 

Web Cameras 

Lightolier Compose Lighting Control System 

Lutron RadioRA Wireless Lighting Control System 

X10 ActiveHome CM11A X10 serial interface (two way interface) and compatibles (HD11A, CM12U) 

ACT TI103 X10 interface (X10 only) 

Applied Digital Ocelot/CPU-XA (X10/Infrared/Input-output serial interface) 

X10 CM17A RF serial interface (one way, send only X10 interface) 

MR26A RF Receiver 

WGL Designs W800RF32 RF Receiver 

SmartLinc HouseLinc home controller (X10 and infrared) 

NIRVIS Slink-e (infrared, Sony Control-S) 

JDS IRXpander (Infrared) 

JDS Stargate 

Custom Solutions HomeVision 

SmartHome PowerLinc 

SmartHome IRLinc model 1623PC 

HAI Omni and OnQ HMS series Home Automation and Security Controllers 

Napco Gemini Security System 

RCS TX and TR series thermostats 

Enerzone (Aprilaire) thermostats 

HAI RC series thermostats 
  

Welcome to HomeSeer! 
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HomeSeer is designed to work with just about any X10 or Z-Wave compatible device.  If you are confused about what Home Automation or 
X10 is, please read the FAQ section before going any further.  The FAQ is available at the HomeSeer website. 

At a minimum, you will need the following: 

An X10 or Z-Wave Interface for your computer.  The CM11A or TI103 connect to your PC’s serial port, the SmartHome 
PowerLinc connects to a USB port on your computer, and HomeSeer's Z-Wave Interface connects to a USB port.  There are 
many other X-10 interfaces supported by HomeSeer. 

Some X10 or Z-Wave plug-in lamp modules. 

Some X10 or Z-Wave plug-in appliance modules. 

If you are using Z-Wave, one master controller is needed (usually a handheld controller). 

  
The easiest procedure for getting started with HomeSeer is to create devices in HomeSeer that represent the devices you want to control 
and then create some events to control those devices.  As you become more familiar with HomeSeer, you may wish to explore more 
advanced automation topics, plug-ins, scripting, and much more. 

  

Some key information:  

HomeSeer has an autosave feature.  Any changes you make to your configuration, either locally or via the web, are saved 
immediately.  There is no need to be concerned about losing data and no need to perform frequent saves.  It may be wise 
to backup your configuration file periodically.  Note that HomeSeer automatically creates a backup file of your configuration. 
 Configuration files have the extension ".mdb".  All configuration information is stored in the config directory in the 
HomeSeer folder.  HomeSeer settings for the program itself are stored in the file SETTINGS.INI which is also in your config 
directory. 

The current configuration file is always displayed in the title bar of the main window.  
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What's New in This Version 

The Framework 

Version 2.0 is built on an architecture vastly different from its predecessors.  This architecture takes full advantage of Microsoft's new .NET 
framework.  The .NET architecture offers what Microsoft calls "Managed Code".  The idea is that anything written in .NET will be much more 
reliable.  The programming languages used by .NET all use the same .NET framework.  The framework offers a consistent Application Program
Interface (API) into the operating system and isolates the application from the hardware.  Frameworks for other operating systems are 
currently in development and this will allow HomeSeer 2.0 to run on other platforms (such as Linux) in the future.  The new environment 
offers HomeSeer the ability to use advanced features such as threading and .NET "remoting" and threading. 

New Features 

HomeSeer Version 2.0 is totally "multithreaded".  This means that every process that needs some amount of time will run in 
its own thread.  For example, every time a script is triggered a new "thread" is created and the script is launched.  So the 
rest of the system is free to process other tasks while also continuing to work on the script. 

HomeSeer has also been broken up into a "distributed architecture".  This means that the main application runs as a service 
on Windows 2000 and XP and is accessed using any web browser.  There is a minimal user interface so most interaction is 
done through the web interface and the web interface is now easier to use. 

The method in which event actions are handled has also been changed.  You can now create your own order of event 
actions.  For example, when an event triggers you can have it speak something, turn on a light, speak something else, send 
an infrared command, turn off another light, etc.  There is no limit to the number of actions and you can specify and order 
them any way you like. 

The main service application is what we call the "scheduler".  This service handles running all scheduled events, scripts, and 
interactions with the automation hardware.  Voice recognition (VR) and text-to-speech (TTS) are handled with an external 
application.  This application, called "Speaker", is an executable that can run on any computer on your network.  This 
application connects to the service application using .NET remoting (similar to DCOM).  When an event needs to speak, it 
does so by sending the speech to the Speaker application.  You can have as many Speaker applications as you like and the 
applications can even be located on the Internet!  HomeSeer can speak to all applications at once or just to specific ones. 
 Voice recognition works the same way.  Each speaker application is a VR client, so VR can be handle at any number of 
computers, all at the same time!  This works over the Internet also. 

Scripts written in .NET are compiled and run as executables.  Scripts can be complete applications and have access to all the 
same resources as a standard .NET application.  Scripts can be written in Visual Basic .NET and C#. Scripts that are written 
in the older VBScript language are still supported, so HomeSeer 2 still runs scripts written for previous versions of 
HomeSeer. 

Version 2.0 is fully compatible with ASP.NET.  Any ASP.NET web page (.aspx) or web application should work.  Creating web 
pages in .NET is much easier than with the old ASP and free tools are available to assist you. 

The web server in Version 2.0 now includes support for SSL (https://), which creates a more secure connection to your 
home over the Internet. 

Several new script commands exist for use in scripts and ASP/ASPX files.  To see what's new, click on Using Scripts and 

then Scripting Functions from the navigation tree to the left and look for the  symbol next to the script procedure name. 
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 System Requirements 

HomeSeer runs under Windows® 2000 and XP.  

You will need a web browser installed if you would like to view your devices or events via a web page or view the web 
version of the online documentation.  HomeSeer has been tested with Microsoft Internet Explorer. 

You will need an Internet account to access your system via the Web. 

TCP/IP must be installed on your computer if you are going to use the built-in web server or E-mail. This is installed by 
default in Windows XP and 2000. 

If you would like to view your local mail, a MAPI compliant E-mail application should be installed, such as Outlook Express 
and Outlook (versions 98 and higher).  With a POP/SMTP E-mail account, it is still possible to have HomeSeer send E-mail 
messages and respond to E-mail sent to it, but it will not display in the built-in E-mail page. 

If you intend to control HomeSeer by voice then you should have a Pentium® processor running at 400 MHz or faster.  You 
also need a good quality microphone for the best recognition accuracy. 

Additional hardware and/or software plug-ins may be required for some features to work.  See the HomeSeer website or 
plug-in programs' documentation for more information. 

  

Other Considerations 

A firewall and/or other security measures must be installed on the HomeSeer computer and/or home network in order to 
protect the system from outside tampering.  If you're unsure how to protect your computer, don't enable the Web 
interface feature or consult a computer expert for assistance in protecting your computer before enabling the Web feature. 
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 Running HomeSeer for the First Time 

Connect any hardware devices that you would like to use with HomeSeer to your computer.  Install any drivers that may be necessary for 
the device and follow the manufacturer's testing procedure to make sure the device is working properly.  Double-click the setup application 
and follow the prompts to install the software.   

A HomeSeer folder is added to the Windows® Start menu.  A HomeSeer icon is added to this folder.  To start HomeSeer, select Start then 
Programs then HomeSeer 2 then HomeSeer 2.  

SAMPLE.MDB 

HomeSeer will load a default configuration file named sample.mdb.  HomeSeer configuration files have the extension .mdb.  This file contains 
some sample devices and sample events.  The file is located in the CONFIG directory which was created within the directory where you 
installed HomeSeer (C:\Program Files\HomeSeer 2\Config by default). 
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Licensing and Registering HomeSeer 

HomeSeer will run for thirty (30) days before it must be licensed.  To bypass this screen without licensing the software, click one of the menu 
sub-items at the top of the Log screen (such as Edit > Setup or View > Events) or right-click on the HomeSeer icon in the Windows status 
bar and select View Devices from the pop-up menu that appears. 

HomeSeer can be licensed from the Software Registration screen (see below) or the License Information screen. To get to the Software 
Registration screen, simply start HomeSeer. The Software Registration screen will continue to appear until HomeSeer is licensed. To get to 
the License Information screen, click Help > Licenses... from the Log screen. 

You must be actively connected to the Internet when licensing HomeSeer.  During the licensing process, the program will 
communicate with servers at HomeSeer Technologies, LLC, to verify your license ID/codes and password.  None of your 
personal information or information about your system will be transmitted. 

Click on the graphic below for more information on this screen. 
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HomeSeer Features 

Extensive Hardware Support 

HomeSeer works with many popular X10 and infrared controllers as well as newer technologies, such as Z-Wave™. 

HomeSeer supports the NAPCO Gemini, Caddx, OnQ, and HAI Omni security panels (there is an extra cost add-on for some 
of these). 

HomeSeer supports the X10 MR26A RF receiver and the WGL Designs W800RF32 receiver, which enable HomeSeer to 
receive commands from X10 motion sensors and other X10 RF wireless transmitters, thereby speeding up motion sensor 
response and providing for some alternate ways to run events that carry out actions. 

Ability to control any X10-compatible device, including devices that support preset dim commands as well as Leviton® 
devices that support the extended dim command. 

HomeSeer supports close to a dozen different devices that have infrared support so that you can control your home music 
and video equipment using HomeSeer. 

HomeSeer supports SmartLinc SwitchLinc, Compose™ PLC, Leviton, PCS, and X10 brand wall switches. 

HomeSeer supports the RCS TX series and TR series thermostats, Enerzone (Aprilaire), and HAI RC-series thermostats. 

HomeSeer supports the JDS Stargate and Custom Solutions' HomeVision controllers. 

HomeSeer supports Z-Wave, the wireless control technology by Zensys found in products manufactured by many leading 
companies including Sylvania, ACT, Wayne-Dalton, and Intermatic. 

More hardware support is available on the HomeSeer website. 

Advanced Programming and Scripting 

.NET framework allows for "multithreading", "remoting", and other features in .NET, and is more reliable and stable. 

Security mode runs timed events randomly within 30 minutes before or after the scheduled time, which is great for creating 
a "lived in" look when you are away. 

HomeSeer runs scripts created in VBScript, JScript, PERLScript, Visual Basic .NET, C#, and Python.  Only VBScript and 
JScript are installed with HomeSeer.  All other scripting languages must be installed separately. 

An extensive programming interface is provided for writing scripts that will totally automate the program. 

Easily Add Features and Functionality 

HomeSeer Phone allows HomeSeer to be controlled from any telephone.  This support also adds answering machine and 
full Caller ID support.  HomeSeer Phone is installed with HomeSeer, but is considered a separate product and requires a 
license. 

A built-in web server allows full control of all your X10 devices via your home network or the Internet. 

Password-secure login to the web server. 

Web Interface and E-mail Support 

Includes SSL support for stronger security when viewing HomeSeer over the Internet. 

If you have a MAPI-compliant E-mail client such as Outlook Express or Outlook® (version 98 or higher), HomeSeer can 
display your local E-mail on a web page.  (HomeSeer can still send and receive E-mail with SMTP/POP E-mail accounts.) 

Device commands may be imbedded in E-mail messages.  This allows you to send an E-mail home to turn devices on and 
off. 

And more... 

Voice control is available with the Speaker Application.  Simply say "computer" and the program will listen for your 
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commands. 

Events may be triggered by time, X10 command received, sunrise/sunset, various conditions like elapsed time on or off, 
by E-mail, by infrared match, by a device status change, by a phone event such as a ring or Caller ID available (HomeSeer 
Phone software required) or a security panel event.  Many more triggers are provided by many third-party or HomeSeer 
add-on plug-ins. 

Event actions include controlling X10 devices, launching applications, sending E-mail, playing sounds, sending infrared 
commands, triggering other events, dialing an Internet connection, or controlling a security panel.  If HomeSeer Phone is 
installed, phone actions are also available such as changing the number of rings before calls are answered.  Many more 
actions are provided by many third-party or HomeSeer add-on plug-ins. 

Built-in TV/Video game timer, which allows you to set time limits on the use of televisions or video games.  Kids are given 
a four-digit password that is entered on a tabletop X10 controller.  HomeSeer will then turn off the TV after a pre-
determined period of time has elapsed.  Time may be set by day or by week. 

Full logging of all actions either performed locally or via the network. 
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How to Interact with and Control HomeSeer 

There are multiple ways to control HomeSeer.  It can be controlled through the web interface, by voice, in response to external stimuli 
(hardware devices, third-party plug-ins, other programs), or programmatically. 

User Interfaces 

There are several graphical user interfaces (GUIs) for controlling HomeSeer.  Some interfaces, however, are only available in certain 
situations, as explained below. 

Web Browser: HomeSeer can be controlled using a web browser on the computer on which HomeSeer is running or from 
anywhere in the world, if the option to do so was enabled in the Web Server Setup screen.  Additional options in this screen 
determine the port the web browser will use to access HomeSeer and whether or not guests can view events.  The features 
accessible through the web browser depend on options set in the Web Server Setup screen and access rights of the user as 
set in the Web Users Setup screen. 

Touchscreens and Pocket PCs: HomeSeer can also be controlled through touchscreens and pocket computers (or PDAs). 
 These interfaces are similar to controlling HomeSeer through web browsers, but the layout of the screens are adjusted for 
easy control through touchscreens or PDAs.  The appearance of the screens are set in the Touchpad Display Setup Admin 
screen, by selecting a specific "skin". 

Selecting a skin in the Touchpad Display Setup Admin screen sets a "cookie" on the computer in which the 
skin was selected.  In this manner, a touchscreen monitor can be set to the "Americana" skin while a PDA 
is set to the "Pocket PC" skin. 

Controlling HomeSeer by Voice 

HomeSeer can be controlled by voice using microphones and/or telephones.  Microphones are any audio input devices connected to the 
computer on which HomeSeer is installed.  Multiple microphones can be installed throughout the house and run to a central audio mixer which
is then connected to the computer.  Telephones refer to phones inside the house and outside, which means that you can call from anywhere 
in the world to talk to HomeSeer.   

Controlling HomeSeer by voice requires installing and configuring the Speaker Application. 

Interacting with HomeSeer by telephone requires the HomeSeer Phone plug-in and a compatible modem.  Go to the 
HomeSeer website for more information on modems. 

Controlling HomeSeer in Response to External Stimuli 

HomeSeer works with numerous hardware devices.  These devices can "trigger" pre-programmed actions in HomeSeer.  For instance, sensors 
embedded in the driveway can trigger HomeSeer to say that someone is approaching when the sensors detect a car.  Likewise, a disarm 
command entered into a security system could trigger HomeSeer to turn on the air conditioner, announce if any new voice messages have 
been received, and turn on some music. 

HomeSeer can also interact with external software programs and third-party plug-ins.  For example, a weather plug-in can report weather 
data and trigger temperature-related events in HomeSeer and a Microsoft® Outlook plug-in can trigger events in HomeSeer based on Outlook
appointments. 

Go to the HomeSeer website for more information on compatible hardware devices and plug-ins.  Interfaces and plug-ins must be enabled 
and configured in the Interfaces Setup screen. 

Controlling HomeSeer Programmatically 

A HomeSeer event contains one or more actions that will run when triggered.  Actions can be anything from HomeSeer speaking a phrase to 
turning on a light to setting the thermostat to 68 degrees.  Events can be run manually or automatically in response to external stimuli (see 
above).  Events can also include conditions, like not sending a command to turn on a light if it's already on or not turning on the air 
conditioning at the normal time because the family is on vacation.   
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Go to the About Events page for more information on events, triggers, actions, and conditions. 
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Technical Support 

Support is available many different ways.  Please visit the Support page of the HomeSeer website for more information.   

Some of the support options are: 

Message Board: From the message board you can view questions and answers other users have asked and you can post 
your questions where others may benefit from the answers.  

Help Desk: Support requests and feature requests may be entered at the Help Desk.  The Help Desk also has links to 
online versions of help files for HomeSeer products. 

Frequently Asked Questions (FAQs): In the FAQ database you can search and view popular questions asked by other 
HomeSeer users. 

Our development process is very open.  As new features are added to the software, updates will be available from the HomeSeer website, 
including beta versions.  Keep in mind that beta versions of the software may not be as stable as the released version.  
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